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Ad Hoc Reports Overview

The ad hoc report writer gives users the ability to create reports and dashboards quickly and easily.

When you design a new report, the report designer leads you through a logical series of steps, beginning
with the choice of a data source. After you have a data source, you can then choose the fields you want to
use in your report. You can configure field attributes such as sorting and grouping, create charts and gauge
panels, choose the colors and shading for your report, and define the header and the footer content. You
can also define who you want to share the report with, and what permissions that you want to allow other
users when interacting with your report.

If your agency has obtained a license key to access the form layout tool in ad hoc reports, you can use the
form layout tool in ad hoc reports to create forms, edit forms, and add data fields.

The design process always presents users with a simple set of actions on each tab that enables even a
novice report writer to create an effective report. However, the process also provides several opportunities
for more advanced configuration and setup for more experienced users.

You can save reports and dashboards and categorize them into folders for easy reference. Saved ad hoc
reports can be re-run as needed. You can update dashboards at the click of a button. Administrators can
upload ad hoc reports to the Reports menu that is available on many portlets.



Ad Hoc Reports Configuration Requirements

To use the ad hoc reports feature in Civic Platform, you must install the tool on your reports server. Some
additional configurations are necessary after the installation.

For complete instructions, see the Civic Platform Installation Guide, available via the Documentation
Library on Community and on the FTP site.



Launching the Ad Hoc Report Writer

You can access the ad hoc report writer and ad hoc reports documentation from the Ad Hoc Report Writer
landing page.

To access the ad hoc report writer

1. Click the Ad Hoc Reports link in the main links section of your Civic Platform console.

The Ac Hoc Reports landing page displays.

2. Click Open Ad Hoc Report Writer.



Working with Existing Reports

Topics

• Running an Existing Report

• Deleting an Existing Report

• Editing an Existing Report

• Exporting a Report

Running an Existing Report

You can run an existing report from the Report List or from the Report Designer.

To run an existing Report from the Report List

1. Open the ad hoc report writer portlet (see Launching the Ad Hoc Report Writer) and locate the report
you want to run.

2. Click the desired report name.

The report runs and its contents display.

To run an existing report from the Report Designer

1. Open the ad hoc report writer portlet (see Launching the Ad Hoc Report Writer).

2. Create a new report, or edit an existing report by clicking the Design icon as shown.

The Report Designer opens.

3. Click the Preview button on any of the tabs or click the Preview tab.

The report runs and its contents display.

Deleting an Existing Report

You can remove existing reports from the Report List as needed.

To delete a report

1. Open the ad hoc report writer portlet (see Launching the Ad Hoc Report Writer) and locate the report
you want to delete.

2. Hover your mouse cursor on the desired report to reveal the report tools to the left.

3.
Click .

4. The ad hoc report writer prompts you to confirm the deletion.

5. Click OK.

The ad hoc report writer removes the report.



Editing an Existing Report

You can modify existing reports in Report Designer, provided that you have permission to do so.

To edit an existing report

1. Open the ad hoc report writer portlet (see Launching the Ad Hoc Report Writer) and locate the report
you want to work with.

• If you are on the Report List, hover your mouse cursor on the desired report to reveal the report tools

to the left. Click .

• If you are on the Report Viewer (accessed by clicking a report name in the Report List), click the
Design button in the toolbar.

2. Make changes to your report as needed. For information about modifying information on the different
tabs, refer to any of the following sections:

• Data Source Section and DB View Relationships Section

• Fields Tab

• Summary Tab

• Chart Tab

• Gauge Tab

• Misc Tab

• Style Tab

3. Click Save to save your changes.

Exporting a Report

You can export ad hoc reports to several different output types, where you can further manipulate the data
as needed.

Note:

When you export a report from Accela Ad hoc Reports, you are exporting it with ‘as of’ data embedded. You
cannot re-run the exported version of the report to update the data. If you want updated data for an export
report, you must re-run the report in Accela Ad hoc Reports and then export it again.

To export a report

1. Open the ad hoc report writer portlet (see Launching the Ad Hoc Report Writer).

2. Create a new report or edit an existing one by clicking the Design icon as shown.

The Report Designer opens.

3. Click the export button corresponding to the format you want to export to. The following formats are
available:



• Adobe Acrobat PDF

• HTML

• CSV that can be imported to a spreadsheet

• Microsoft Excel

• Microsoft Word

• XML

4. After the report is downloaded, you can open or save the exported file.



Designing a New Report

Civic Platform ad hoc reports are easy to create and easy to modify. The design form walks you through
the report creation process, making it an easy process for simple reporting needs, while providing more
robust features that experienced report writers can use to create more complex reports.

The ad hoc report writer walks you through a series of tabs where you can add a data table, a report
summary, a chart, and/or a panel of gauges. You can add all of these elements, or you can add only the
elements that you want. For example, if you just want to create a chart for use in a dashboard, skip to the
Chart tab after you select your data source and define your chart as described in Chart Tab.

Topics

• Creating a Report

• Adding Templates to Your Data Source

• Visually Grouping by Field Value

• Creating a Calculated Column

• Adding a Pivot Column

Related Information

• Izenda Report Design Guide

Creating a Report

The following procedure describes how to design a new report with all the elements included.

To creating a simple new report

1. Open the ad hoc report writer portlet (see Launching the Ad Hoc Report Writer).

The Ad hoc Report portlet opens and displays the Report List.



2. Click Design a New Report.

The Ad hoc Report Designer displays the Data Sources page which lists the DB_Views available to you
for reporting.

3. Select the DB_Views you want to use in your report. If you want to use template data in your report,
select the DB_View associated with the template you want to use (see Data Source Templates for Ad
Hoc Reporting).

The Add Fields button becomes enabled. If you selected multiple tables, the DB View Relationships
section automatically expands.



4. Do one of the following:

• If you selected only one DB_View and do not plan to use template data in your report, proceed to the
next step.

• If you selected a DB_View with the intent of selecting an associated template, click the Template

button .

• for the related DB_View and follow the process described in Adding Templates to Your Data Source.

• If you selected more than one data source for your report, use the DB View Relationships section to
create joins between the selected data sources.

5. Select Distinct if you want to remove duplicates from the result set.

Note:

Marking the Distinct check box inserts the DISTINCT clause into the sql SELECT statement you are
building. After you select fields in the Fields tab, you can click the SQL button to see how the DISTINCT
clause appears in the SELECT statement you are creating.

6. Click Add Fields.

The Fields tab displays. The Field drop-down list includes the fields from the selected data source(s).
If you chose more than one data source, the fields from each selected data source display beneath the
data source name wherein the fields reside. If you added ASI/ ASIT templates to a data source, the
template fields display separately beneath the template name.



Note:

The Field drop-down list excludes data source fields that ad hoc report writer does not use in the DB
View Relationships, even if the data source is selected in the Data Source (Views and Tables) section.

7. From the Field drop-down list, select a field to add to your report.

Note:

Use the Quick Add button to display a checklist of all available fields. Go through the list and select each
field you want to add to your report, then click OK. The ad hoc report writer adds the selected fields. You
still need to set the attributes for each field (See Fields Tab).

The Description field auto-populates from the data source.

8. Define how you want the field data displayed in your report. See Fields Tab for information about field
attributes.

9.
To add another field to your report, click  to insert a field above the existing row, or  to insert a
field below the existing row. See the Tip in step 7 for an alternate method for adding fields.

10.Repeat steps 7 and 8 for each new row.

11.If you want to add pivot columns to your report, click Add Pivot (see Adding a Pivot Column).

12.If your agency has obtained a license key to access the form layout tool, and you want to create a form
layout for your report, click Design Form (see Working with the Form Layout Tool).

13.When you finish adding fields, click Continue to Summary.

14.If you want to add a Summary section to your report, configure your summary report (see Summary
Tab).

15.Click Continue to Chart.

16.Select the type of chart you want to create. Configure your chart as described in Chart Tab. See
Working with Graphs for further information.



Note:

Use Preview to view your chart settings as needed. Use the Filters tab to define limits on the data used
for your chart as needed. See Filters Tab for more information.

17.Click Continue to Gauge.

18.Configure your gauges as described in Gauge Tab.

19.Click Continue to Misc.

20.Enter text in the Title, Description, Header, and Footer fields as needed.

21.Use the Justification button (see image below) for each of these elements as well as for the Report
Header Image to define what type of justification you want to apply to the element. The choices are (L)
left justification, (R) right justification, and (M) middle/center justification.

22.Define whom you want to be able to access your report, and what you want to allow them to do. See
Misc Tab for details.

23.Click Continue to Style.

24.Use the settings on the Style tab to enhance the visual appearance of your report. See Style Tab for
details.

25.Complete your report, then click Save As in the toolbar.

Civic Platform prompts you to name a report and category (optional).

26.Enter a name for your report where indicated.

27.If you want to store the report in a category, select an existing category name from the drop-down list or
choose Create New to enter a new category name.

28.Click OK.

Civic Platform saves your new report.

Adding Templates to Your Data Source

If a data source has pre-defined templates, you can choose one or more of those templates to include
in your data source for reporting. Your agency administrator may define one or more templates for
a data source. Each template contains a series of additional information fields on records, workflow
tasks, addresses, parcels, owners, conditions, licensed professionals, or contacts. For example, your
administrator may define a group of application-specific information fields (ASI) for each record type. Civic
Platform lists the ASI and ASIT groups associated with all record types in the template selection window.
Civic Platform lists them as templates for the “V_Record” data source.



For more information about which data sources have pre-defined templates and what those templates are,
see Data Source Templates for Ad Hoc Reporting.

To add templates to your data source

1. In the Ad hoc Report portlet, open the Data Sources page either by creating a new report (see
Designing a New Report) or by opening an existing report and clicking the Data Source button.

The Data Source (Views and Tables) page displays.

2. Click the Template button  for the DB_View associated with the template that you want to use for
reporting.

The template selection window appears.

3. If needed, click Filter and enter filter criteria to refine the list of displayed templates.

Note:

Available filter fields vary by data source. For example, you can filter templates for the data source
“V_Addresses” by template name and filter templates for “V_CONDITION_RECORD” by template name,
condition group, and condition type.

The template selection updates to display only those templates meeting your filter criteria.

4. Select each template that you want to use.

5. Click Submit.



Table 89: Data Source Templates for Ad Hoc Reporting

Template Category What Makes Up the Template
Name

Description

ASI(application-
specific information
fields)

ASIT::ASIT Group Code::ASIT
Subgroup Code

Civic Platform lists the ASI groups associated
with each record type as templates for these
data sources: V_RECORD_LICENSE,
V_RECORD_DATES_STAFF, V_RECORD.

ASIT (application-
specific information
tables)

ASIT::ASIT Group Code::ASIT
Subgroup Code

Civic Platform lists the ASIT groups associated
with each record type as templates for these
data sources: V_RECORD_LICENSE,
V_RECORD_DATES_STAFF, V_RECORD.

TSI(task-specific
information fields)

TSI::TSI Group Code Civic Platform lists all TSI groups as templates
for this data source: V_WORKFLOW.

Address Template Address Template Name Civic Platform lists all APO templates of the
“ADDRESS” attribute type as templates for this
data source: V_ADDRESS.

Parcel Template Parcel Template Name Civic Platform lists all APO templates of the
“PARCEL” attribute type as templates for this
data source: V_PARCEL.

Owner Template Owner Template Name Civic Platform lists all APO templates of the
“OWNER” attribute type as templates for this
data source: V_OWNER.

Checklist Template GUIDESHEET_TPL::ASI Group

Code

You can associate a checklist item with an
ASI group. Civic Platform lists the ASI groups
associated with each checklist item as templates
for this data source: V_GUIDESHEET.

Reference Contact
Template

PEOPLE_REF::Contact Type Civic Platform lists the people templates defined
for each reference contact type as templates for
this data source: V_REF_CONTACT.

Record Contact
Template

PEOPLE_DALIY::Contact Type Civic Platform lists the people templates defined
for each record contact type as templates for this
data source: V_CONTACT.

Record Condition
Template

RECORD_COND_TPL::ASI Group
Code

Civic Platform lists the ASI groups associated
with each type of record conditions as templates
for this data source: V_CONDITION_RECORD.

Standard Condition
Template

STD_COND_TPL::ASI Group Code Civic Platform lists the ASI groups
associated with each type of standard
conditions as templates for this data source:
V_STANDARD_CONDITION.

Record Licensed
Professional Template

LP_TPL::License Type You can associate a licensed professional with a
record. Civic Platform lists the people templates
defined for each type of record-related licensed
professionals as templates for this data source:
V_PROFESSIONAL.

Reference Licensed
Professional Template

LP_REF_TPL::License Type Civic Platform lists the people templates defined
for each reference licensed professional
type as templates for this data source:
V_REF_PROFESSIONAL.



You can use more than one data source for a report. When you select multiple data sources, you need to
define the relationship (join) between the data sources in the DB View Relationships section at the bottom
of the Data Source (Views and Tables) page. In most cases, users do this by identifying a common column
(field) on both tables that helps tie the two tables together and then they specify the type of join between
the tables.

To specify multiple data sources for your report

1. In the Ad hoc Report portlet, open the Data Sources page either by creating a new report (see
Designing a New Report) or by opening an existing report and clicking the Data Source button.

The Data Source (Views and Tables) page displays.

2. Select each data source that you want to use in your report.

The DB View Relationships section automatically expands when you select more than one data source.

3. From the first row of the DB View Relationships list, select the first data source from the drop-down list.

4. Click the  Insert Row button on the right side of the window.

Civic Platform inserts a new row.

5. Complete the new row as follows:

First cell Select the second data source.

Second cell Select a column in the second data source that can be mapped to a column in the
first data source.

Third cell Read-only. This field contains the operator “=”

Fourth cell Select the first data source.

Fifth cell Select a column in the first data source to map to the column you selected for the
second cell.



Sixth cell Select the type of join you want to create. The following join types are available:

Inner (Direct) Join: An inner join selects rows from two tables such that the value
in a column for the first table also appears in a column for the second table.

Cross Join: A cross join returns a result table where each row from the first table
combines with each row from the second table.

Left (First Exists) Join: A left join (left outer join) returns all rows from the left table
in the left outer join clause, whether the joined columns have a match or not. A field
in a result row displays a null if the corresponding table does not contain a matching
row.

Right Join: A right join (right outer join) returns all rows from the right table in the
right outer join clause, whether the joined columns match or not. A field in a result
row displays a null if the corresponding table does not contain a matching row.

Full Join: A full join (full outer join) returns all rows from both the right outer and left
outer joins. A field in a result row displays a null if the corresponding table does not
contain a matching row.

The Ad Hoc Report tool creates the desired join between the selected data sources.

6. To create another join between the same data sources, or between the one of the previously joined

data sources and a third data source, click the  Insert Row button to insert a new data source row,
then repeat step 5.

Note:

The fourth cell on a new row is a drop-down list containing the data sources that you selected in the first
cells of all the previous rows and the new row.

Visually Grouping by Field Value

You can group data rows by field in your report, using field values as subheadings for each group.

Example

You can create a payment report that lists the Payment Method (where check, credit card, and cash are
the options), the Payment Amount, and the Payment Date.

If you leave VG blank for all fields, your report displays a single table with 3 rows of data as shown.

If you mark VG for Payment Method, your report displays a series of two-column tables - one table for each
Payment Method value. Civic Platform uses the Payment Method values as these sub-table headers.



Creating a Calculated Column

You can create a calculated column for your report that performs basic arithmetic operations using field
values.

To create a calculated column

We want to sum the field A value and the field B value to get a new value C (A+B=C). In our report display,
we want to display field A as the first column, field B as the second column, and the new calculated column
C as the third column.

Note:

You do not need to display field A and field B in the report to use them in creating a calculated column.

1. Open the Ad hoc Report portlet.

2. Create a new report or edit an existing one by clicking the Design icon as shown.

The Report Designer opens.

3. Make sure you have a data source selected. See Data Source Section and DB View Relationships
Section.

4. Go to the Fields tab.

5. Create the first column:

• Select Field A from the Field drop-down list.

6. Click the Add New Row Below button.

7. Create the second column:



• Select Field B from the Field drop-down list in the new row.

8. Create the third column, which is the calculated one:

• Click the Add New Row Below button.

• Select Field A from the Field drop-down list.

• Type TOTAL in the Description.

• Click the Add New Row Below button.

• Select Field B from the Field drop-down list.

• Click the A box for the Field B row until a + displays.

Civic Platform disables the Field B Description and Format fields and uses these values from the
Field A row, for column C. When you run the report, Civic Platform labels Column C with TOTAL,
and displays the sum of the values in column A and column B as shown below.

Adding a Pivot Column

The Pivot feature allows users to generate analytical data grids from within a report, essentially adding
extra pivot columns to the right side of the report. Pivot columns are useful for comparing data over
multiple categorical dimensions. For example, you can create a report that lists inspections by type and the
number of each type for the year to date. To that, you can add pivot columns that break out the number of
inspections by month, with monthly sub-totals listed.

To add a pivot column

In this scenario, we are going to create a report that lists the number of inspections performed for the
current year and visually group the data by inspection type. Then we are going to add a pivot that further
breaks out the number of inspections by month for each inspection type.

1. Open the Ad hoc Report portlet.

2. Create a new report or edit an existing one by clicking the Design icon as shown.



The Report Designer opens.

3. On the Data Sources tab, select the V_INSPECTION data source.

4. On the Fields tab, set the following fields as shown:

The preview shows these results.

5. Return to the Fields tab and click Add Pivot.

The Add Pivot Columns controls display.

6. Set the fields as shown:

The preview shows these results.



Designing a New Dashboard

A dashboard is a convenience that enables you to set up a display that shows multiple report sections,
such as a chart, a summary, or a list of fields, on a single page. For example, the manager of a city’s
building permits department may create a dashboard view that displays updated graphs that allow him
to monitor the number of scheduled vs. completed inspections, the types/quantities of permits being
requested, and fee payment data. He can check this dashboard to get an up-to-date snapshot of his
department’s activities without having to go in and run each report separately.

Note:

Dashboards make use of existing reports. Create your reports first, then create your dashboard.

To design a new dashboard

1. Open the ad hoc report writer portlet (see Launching the Ad Hoc Report Writer).

The Ad hoc Report portlet opens and displays the Report List.

2. Click Design a New Dashboard.

The Ad hoc Dashboard Designer displays.

3. In the first set of report selection fields, complete the following fields:

Title Enter the title for the report.

Report From the drop-down list of existing reports, select the report you want to add to your
dashboard display.

Records From the drop-down list, select the number of records to show.

Report Part Select which part of the selected report you want to display in your dashboard.
Choices may include Chart, Gauges, Summary, or Detail, depending on which parts
are available in the source report.

4. Repeat the previous step for each new report you want to add to your dashboard. You can add up to 11
reports.



5. Set the permissions for your dashboard by selecting values from the Share With and Rights drop-down
lists. The Share With field defines who can access your dashboard. The Rights field defines what other
users can do with your dashboard.

6. Use Preview to see how your dashboard looks. To return to the Dashboard Designer, click the Design
button.

7. When you finish, click Save As, enter a name for your dashboard, and select a category in which to
store the dashboard.

8. Click OK.



Working with Graphs

Using tools on the Charts tab, you can create the following types of charts to illustrate data trends,
compare values, or show a progression.

• Trend Charts

• Pie Charts

• Plot Charts

• Bar Charts

• Funnel Charts

Trend Charts

Use a trend chart when you want to view the pattern of change in a data element over a period of time.

Figure 26: Trend Chart Example

To create a trend chart

1. Open the ad hoc report writer portlet (see Launching the Ad Hoc Report Writer) and either click the Edit
icon for an existing report, or click Design a New Report.

2. If you are designing a new report, select one or more data sources. See Data Source Section and DB
View Relationships Section.

3. Go to the Charts tab.

4. From the Chart Type drop-down list, select Trend.

5. Enter a title for the chart in the Title field.

6. Select the date field you want to use for measuring progress on the x-axis.

7. Select an option from the Function drop-down list to apply to the date field. For example, choose
Group(Month Name) to display data by month.



Note:

The Function options can impact your x-axis unit labels. For example, if you choose Group(Month), the x-
axis labels display numerical values representing the months of the year (1 for January, 2 for February,
and so forth). If you choose Group(Month Name), the x-axis labels display the abbreviated names of the
month (Jan for January, Feb for February, and so forth).

8. Select Sort to sort the values chronologically. If you do not check this box, the field labels may not
appear as you expect them to.

9. From the Value drop-down list, select the field you want to use for the y-axis. Your selection is the value
you want to track over time. For example, if you want to track the amount of payments received over
time, you can choose the Amount field.

10.Select an option from the Function drop-down list to apply to the Value you just selected. For example,
you can choose Sum to sum the data for the Value field for each period of time defined by the Date
function.

11.Optional: Click Advanced Properties to see additional chart settings.

12.Complete additional chart attributes as described in Trend Chart Fields and Settings.

13.Either save your work, or click Continue to Gauge.

Pie Charts

Use a pie chart when you are comparing parts of a whole. The circle represents the “whole,” whereas each
‘slice’ of the pie corresponds to a percentage of the whole that each part of the whole represents.

Figure 27: Pie Chart Example

To create a pie chart

1. Open the ad hoc report writer portlet (see Launching the Ad Hoc Report Writer), and either click the Edit
icon for an existing report, or click Design a New Report.

2. If you are designing a new report, select one or more data sources. See Data Source Section and DB
View Relationships Section.

3. Go to the Charts tab.



4. From the Chart Type drop-down list, select Pie.

5. Enter a title for the chart in the Title field.

6. Enter a number in the Records field to limit how many records you want to use to create the chart.

7. Select a field from the Label drop-down list. Civic Platform uses the values from this field to define the
different portions of the pie chart.

For example, you want to create a pie chart that shows the percentage of total payments for each of
five payment methods. You can use Payment_Method as the label.

8. Select an option from the Function drop-down list to apply to the Label field (for example, Group).

9. Select a field from the Value drop-down list.

For example, you want to measure the percentage of total payments for each of five payment methods.
You can use Amount as the Value.

10.Select an option from the Function drop-down list to apply to the Value field (for example, Sum).

11.Optional: Click Advanced Properties to see additional chart settings.

12.Complete additional chart attributes as described in Pie Chart Fields and Settings.

13.Either save your work, or click Continue to Gauge.

Plot Charts

Use a plot chart when you are tracking changes over a long or short period of time. It is common to apply
a date or time value to the x-axis, and a secondary value, such as number of inspections per day, to the y-
axis.

Figure 28: Plot Chart Example

To create a plot chart

1. Open the ad hoc report writer portlet (see Launching the Ad Hoc Report Writer), and either click the Edit
icon for an existing report, or click Design a New Report.

2. If you are designing a new report, select one or more data sources. See Data Source Section and DB
View Relationships Section.



3. Go to the Charts tab.

4. From the Chart Type drop-down list, select Plot.

5. Enter a title for the chart in the Title field.

6. Enter a number in the Records field to limit how many records you want to use to create the chart.

7. Choose a field to use for the x-axis values. Users often choose a date field.

8. From the drop-down list, choose a function to apply to the field you just selected (for example, Group).

9. Choose a field to use for the y-axis values.

10.From the drop-down list, choose a function to apply to the field you just selected (for example, Sum).

11.Optional: Click Advanced Properties to see additional chart settings.

12.Complete additional chart attributes as described in Plot Chart Fields and Settings.

13.Either save your work, or click Continue to Gauge.

Bar Charts

Use a bar chart when you want to compare data between different groups or you want to track changes in
data over time.

Figure 29: Bar Chart Example

To create a bar chart

1. Open the ad hoc report writer portlet (see Launching the Ad Hoc Report Writer), and either click the Edit
icon for an existing report, or click Design a New Report.

2. If you are designing a new report, select one or more data sources. See Data Source Section and DB
View Relationships Section.

3. Go to the Charts tab.

4. From the Chart Type drop-down list, select Bar.



5. Enter a title for the chart in the Title field.

6. Enter a number in the Records field to limit how many records you want to use to create the chart.

7. From the Label drop-down list, choose a field to use for the x-axis values. Users often choose a date
field.

8. Choose a function to apply to the field you just selected (for example, Group(Month)).

9. From the Value drop-down list, choose a field to use for the y-axis values.

10.Choose a function to apply to the field you just selected (for example, Sum).

11.Optional: Click Advanced Properties to see additional chart settings.

12.Complete additional chart attributes as described in Bar Chart Fields and Settings.

13.Either save your work, or click Continue to Gauge.

Funnel Charts

Use a funnel chart to illustrate a sales analysis of potential revenue over a series of stages.

Figure 30: Funnel Chart Example

To create a funnel chart

1. Open the ad hoc report writer portlet (see Launching the Ad Hoc Report Writer), and either click the Edit
icon for an existing report, or click Design a New Report.

2. If you are designing a new report, select one or more data sources. See Data Source Section and DB
View Relationships Section.

3. Go to the Charts tab.

4. From the Chart Type drop-down list, select Funnel.

5. Enter a title for the chart in the Title field.

6. Enter a number in the Records field to limit how many records you want to use to create the chart.



7. From the Label drop-down list, choose a field to use for the x-axis values. Users often choose a date
field.

8. Choose a function to apply to the field you just selected (for example, Group(Month)).

9. From the Value drop-down list, choose a field to use for the y-axis values.

10.Choose a function to apply to the field you just selected (for example, Sum).

11.Optional: Click Advanced Properties to see additional chart settings.

12.Complete additional chart attributes as described in Funnel Chart Fields and Settings.

13.Either save your work, or click Continue to Gauge.



Working with Categories

Topics

• Creating a New Category

• Copying a Report to Another Category

• Deleting a Category

Creating a New Category

Before you create new categories, be aware that renaming and deleting categories is currently not
supported. Once you create a category, it is part of your ad hoc report list display. A good strategy may be
to pre-plan your report categories. Another strategy might involve report categories specific to users (for
example, ‘Tom’s Reports’ or ‘Manager Reports’).

To create a new category

1. Open the ad hoc report writer portlet (see Launching the Ad Hoc Report Writer).

2. Either create a new report/dashboard, or open the design form for an existing report/dashboard that you
want to assign to the new category.

3. Click Save As.

Civic Platform prompts you to input a report name and select a category to which to assign the report.

4. From the Category drop-down list, choose (Create new).

Civic Platform prompts you to enter a category name.

5. Enter a category name. You may use spaces, capitalization, and hyphens. Avoid other special
characters.

6. Click OK.

You are returned to the Input Report Name dialog with the new category name displayed in the
Category field.

7. Click OK.

Civic Platform prompts saves the report name and new category, and the new category is now appears
in the Category drop-down list for naming/assigning reports and dashboards.



Copying a Report to Another Category

You can copy a report from one category to another as needed. The process for doing so is very similar
to the process for creating a new category, except that you can either create a new category or select an
existing category from the Category drop-down list.

See Creating a New Category.

To copy a report to another category

1. Open the ad hoc report writer portlet (see Launching the Ad Hoc Report Writer).

2. Open the design form for an existing report/dashboard that you want to copy by clicking the Design
button to the left of the desired report. Note that the Delete and Design buttons for a report become
visible when you hover your mouse cursor on the report name.

3. Click Save As.

Civic Platform displays the current report name and category.

4. From the Category drop-down list, choose either another existing category or (Create new).

5. If you chose Create new, enter a category name and click OK. Otherwise, skip this step.

Civic Platform displays the Input Report Name dialog with the new category name showing in the
Category field.

6. Click OK.

Civic Platform copies the report to the new category.

Deleting a Category

Remove unwanted categories by emptying them of contents. If you have a category you do not want, do
the following:

1. If you want to save any of the reports or dashboards in the category you are removing to another
category, copy them to the new categories now. See Copying a Report to Another Category.

2. Delete each report and dashboard within the category you want to remove. See Deleting an Existing
Report.

When you remove the last report/dashboard from the category, Civic Platform removes the category as
well.

Note:

You may need to refresh your browser or clear your browser cache to make the empty category
disappear from your Report List view.



Working with the Form Layout Tool

You can use the form layout tool in ad hoc reports to design and create forms that you can populate with
Civic Platform data, resulting in customized document output.

For example, you can create an invoice form that populates with data from the database. When you run the
report, Civic Platform creates a separate, customized invoice for each record included in the report.

Note:

Agencies must obtain a license key to access the form layout tool.

Topics

• Creating a New Form

• Creating a New Form Using Existing HTML Code

• Adding a Table to a Form

• Adding Fields to a Form

• Adding Graphical Elements to a Form

• Adding a Hyperlink to a Form

• Adding a Bookmark and Linking to It

Related Information

• Izenda Report Design Guide > Izenda Forms

Creating a New Form

Novice and expert users alike can use the form layout tool to create letters and forms. You can create
letters and forms from scratch as described below, or you can copy the html code from an existing letter
or form and paste it into the form layout tool, where you can add fields (see Creating a New Form Using
Existing HTML Code).

BEST PRACTICES TIP: If your letter or form does not already exist, take a few minutes to plan the
letter/form contents before you begin working in the form layout tool. Identify the graphics you need, any
hyperlinks you want to create, and what database fields you want to use in the form. Write a list of the
database fields you want to use, so you can be confident that you are spelling the field names correctly
when you insert them into your form.

Note:

Work with the Display Document Structure button  enabled to better see how your form layout is
proceeding.

To create a form or letter

1. Open the ad hoc report writer portlet (see Launching the Ad Hoc Report Writer).

2. Select the database source for your report

3. Go to the Fields tab.

4. Select the fields you want to use in your form.



5. Write down the field names exactly as they appear. You will need this information later.

6. Click the Design Form button.

The form layout tool displays.

7. Enter all text content that you intend to be common to each form that runs. For example, you can enter
a title to a form, or the body of a form letter. Do not format the text yet.

8. If you want any information or data in your form/letter to appear in columns, create a table and use the
columns in the table to organize your data (see Adding a Table to a Form).

Note:

You can use tables to control your form layout as well. For example, your form might be on letterhead,
with a header title and your agency’s logo in the same horizontal space on your form. You can create a
2-column table without lines and put the logo in one table cell, and the header content in the other cell.

9. Using the list of fields you wrote down in step 4, enter each field you want to include in your form
in the location where you want it to appear. Enclose each field name in square brackets. Example:
[record_id]. (see Adding Fields to a Form).

10.Insert horizontal lines, graphics, and page breaks as needed (see Adding Graphical Elements to a
Form).

11.Format the text as you want it to appear. For example, apply a new font style and size to your header.

12.Click OK when you are done.

Civic Platform closes the form layout tool and then returns you to the Fields tab.

You can proceed with report setup as described in Designing a New Report.



Creating a New Form Using Existing HTML Code

You have the ability to create new forms by copying the HTML code from an existing letter or form and
pasting it into the form layout tool, where you modify the contents as needed.

Note:

Work with the Display Document Structure button  enabled to better see how your form layout is
proceeding.

To create a form or letter using existing HTML code

1. Open the ad hoc report writer portlet (see Launching the Ad Hoc Report Writer).

2. Select the database source for your report

3. Go to the Fields tab.

4. Select the fields you want to use in your form.

5. Write down the field names exactly as they appear. You will need this information later.

6. Locate the source document you want to copy, such as a XML or HTM file.

7. Double-click the file to open it in your browser.

8. Right-click in the page display.

A command menu displays.

9. Select View Source.

The source code for the page displays.



10.Click within the window, then press Ctrl+A to select all of the contents of the window.

11.Press Ctrl+C to copy the contents to the clipboard.

12.Navigate to the ad hoc reports form layout tool, and click Design Form.

13.Click the HTML Source Code button.

14.On the Source Code window, press Ctrl+V to paste the contents of your clipboard to the form layout
tool.

15.Click Insert and Close button on the Source Code window to view the content in WYSIWYG format.

16.Using the list of fields you wrote down in step 4, enter each field you want to include in your form
in the location where you want it to appear. Enclose each field name in square brackets. Example:
[record_id] (see Adding Fields to a Form).



17.Insert horizontal lines, graphics, and page breaks as needed. (see Adding Graphical Elements to a
Form).

Note:

To have each instance of your form appear on a separate page, use the Page Break button to insert a
break at the bottom of your form. For example, you have an invoice form, and you want each invoice that
Civic Platform creates when you run the report to be on a separate page.

18.Edit the form content as needed to make it appear the way you want it.

19.Click OK when you are done.

Civic Platform closes the form layout tool and then returns you to the Fields tab.

For more information about designing report forms, see the Izenda Report Design Guide > Izenda Forms.

You can proceed with report setup as described in Designing a New Report.

Adding a Table to a Form

You can use tables in a form to display data in a columnar format. You can also use tables to regulate
where on a page that you want form elements to appear. For example, if you want to create letterhead for
a letter that includes your agency logo on the left and your agency name and address on the right, you can
use a table to align these elements side by side.

You can add a table to a form in the form layout tool with the click of a button. Use the table editing buttons
to modify your table as needed.

Note:

Work with the Display Document Structure button  enabled to better see how your table appears. This is
especially useful if you do not define borders for your table.

To add a table to a form

1. With the form layout tool open, position your cursor where you want to place the table.

2. From the Table menu, select Insert table and choose the number of rows and columns.

3. To see the table properties, select the table on the form designer, and select Table > Table properties.



Adding Fields to a Form

You can add field markers to your form that tell Civic Platform which data elements to use in your form.
When you run your report, Civic Platform replaces those field markers with data from the fields you
indicated, creating custom letters and completed forms. For example, you can create a form letter and
insert field markers for the contact’s name and address. When you run the report, Civic Platform populates
those markers with the name and address of each record it uses in the run. Your output is a series of form
letters; each letter has the form letter content, but different names and addresses.

Field markers are easy to create. Simply enter the name of the database field you want to use, enclosed
in square brackets. For example, to create a marker for the record_ID field, enter [record_ID] in the form
layout tool. It is good practice to write down the list of fields you want to use while you are in the Fields tab.
Doing so gives you the opportunity to double check the field name spelling and syntax.

You can use tables to regulate where on a page that you want field markers to appear. For example, you
can create columns and place field markers in the cells so that the data aligns when you run the report
(see Adding a Table to a Form).

To add field markers

1. On the Fields tab for your report, select the fields you want to use in your form (see Designing a New
Report).

2. As you select fields, write down the names of the fields. You may find that the written list is handy when
you are working in the form layout tool.

3. Click the Design Form button.

The form layout tool displays.

4. Position your cursor where you want to place the field.

5. Enter the name of the field you want to place, enclosed in square brackets. For example, to create a
marker for the record_ID field, enter [record_ID] in the form layout tool.

6. Apply font styles and formatting as needed.

Adding Graphical Elements to a Form

You can enhance your form’s appearance by inserting graphics, such as an agency logo, or by inserting
horizontal rules (lines) as needed.

Topics



• Adding a Horizontal Rule

• Inserting a Graphic

Adding a Horizontal Rule

You can add a horizontal rule (line) to your form when you want to visibly distinguish one section of your
form from another.

1. With the form layout tool open, position your cursor where you want to insert the line.

2. From the Insert menu, select Horizontal line.

Civic Platform places the horizontal rule (line) as defined.

Inserting a Graphic

1. With the form layout tool open, position your cursor where you want to place the graphic.

2. From the Insert menu, select Insert image.

3. In the Source field, enter the location and name of the graphic you want to insert. You can use a URL
address or a file directory address (for example, c:\graphics\agency_seal.jpg).

4. If you are an experienced HTML coder, you can enter HTML code in the Source code window.

Adding a Hyperlink to a Form

You can create hyperlinks in your forms as needed. When your report runs, the hyperlinks you created
provide readers of the electronic report with a link to a URL you specify. For example, you can insert a
hyperlink that customers can click to access your agency’s website.

To add a hyperlink to a form

1. With the form layout tool open, position your cursor where you want to create the hyperlink.

2. Enter the text that you want to use as the base for your hyperlink. For example, if you want to create a
hyperlink to your agency’s website, you can enter your agency’s name.



3. Highlight the text that you want to use for your hyperlink.

4. From the Insert menu, select Insert link.

The Insert link dialog box displays.

5. Enter the URL and other link properties.

6. Use the Target field to define whether you want the linked site to display in the current window or in a
new window.

7. Click OK.

Civic Platform displays the new link as a colorized, underlined object. When you run the report, or when
you use Preview, you can test the link.

Adding an Anchor and Linking to It

You can add an anchor ("bookmark") to an object within a form, and then create a link to that bookmark
from another location within your form. For example, you can insert a bookmark where your agency’s
address and phone number appear in the form, and then create a hyperlink in the form body that instructs
the reader to click the link to see the agency address.

To add an anchor and create a link to that anchor



1. With the form layout tool open and your form displayed, position your cursor where you want to insert
the bookmark. This location is the destination for the link you want to create.

2. From the Insert menu, select Anchor. On the Anchor window, enter the name of the anchor.

Civic Platform inserts an invisible marker in the form at the location you indicated.

3. Go to the location in your document where you want to create the hyperlink.

4. Highlight the text that you want to use for your hyperlink.

5. From the Insert menu, select Insert link.

The Insert link dialog box displays.

6. From the Anchors drop-down list, select the name of the anchor you created.

7. Use the Target field to define whether you want the linked site to display in the current window or in a
new window.

8. Click OK.

Civic Platform displays the new link as a colorized, underlined object. When you run the report, or when
you use Preview, you can test the link.



Ad Hoc Reports Button and Field Reference

Whether you are creating a new report or a new dashboard, or accessing an existing report or dashboard,
you use the ad hoc report writer. The topics in this section describe what you see both on the Report List
page and on the Report/Dashboard Designer.

Topics

• What You See on the Ad Hoc Report Writer List

• What You See on the Report Designer

• What You See on the Dashboard Designer

Additional Reference

• Izenda's Report Design Guide

 

What You See on the Ad Hoc Report Writer List

When you first open the ad hoc report writer, you see a display called the Report List. The display contains
both a report list (organized by category), and hyperlink commands to design a new report and a new
dashboard, as shown in the figure below. Clicking either of the Design hyperlinks opens the Report/
Dashboard Designer.

The categories, or folders, are user-defined, and you can decide which reports or dashboards to assign to
a category. Click any category to expand or collapse the contents.

Each report in the list has a set of tools you can use to interact with that report. Which tools you can use on
a given report depends on your User ID permissions to that report.

To see the toolbar for a report, hover your mouse cursor on the report name in the Report List. The report
tools display to the left of the report name as shown in the figure below.



Table 90: Report Toolbar Icons

Button Control Name Description

Delete Click this button to delete the report.

Edit Click this button to edit the report. The Report Designer opens.

Report Name The report name is a hyperlink. When you click the name, the report runs
and then displays.

What You See on the Report Designer

The Report Designer provides users with a series of tabs that divide the report building tasks into logical
groupings.

Descriptions of the Reports Designer toolbar, the common record controls, the data source sections, and
the Report Designer tabs are available in the following sections.

Topics

• Report Designer Toolbar

• Record Control Buttons

• Data Source Section and DB View Relationships Section

• Fields Tab

• Summary Tab

• Chart Tab

• Gauge Tab

• Misc Tab

• Style Tab

Report Designer Toolbar

A common element to all the tabs on the Report Designer, the toolbar contains a series of buttons you can
use while working in Report Designer.

Hover your mouse cursor over any button to see a brief definition of the button’s function. If the button is
not active for any reason, Civic Platform displays a ‘no access symbol,’ as illustrated in the example below.

For additional reference, see Izenda's Toolbar documentation.

The following table lists and defines the buttons available in the Report Designer toolbar:



Table 91: Record Control Buttons

Button Control Name Description

Report List Returns user to the Report List page. If you did not save your
report, you may lose your work.

New Creates a new report (without having to return to the Report
List page). If you have been working on another report,
remember to save your changes before clicking New.

Save Saves a new report or saves changes to an existing report.

Save As... Saves a report with a new name, or an existing report to
another category, or a new category (see Creating a New
Category).

Print Prints your report to PDF. For a hard copy, you can print the
PDF to your printer.

SQL Displays the SQL logic that defines your report.

CSV Exports the report to CSV (comma delimiter) format.

Excel Exports the report to Excel (XLS) format.

Word Exports the report to Word format

XML Exports the report to XML format.

RTF Exports the report to Rich Text Format (RTF).

Results field Defines the number of records to display when previewing a
report.

Record Control Buttons

Many of the tabs share record controls that give you the ability to add additional records, as well as delete
and reorganize them. The following table lists and describes those controls.

Table 92: Record Control Buttons

Button Control Name Description

Delete Deletes the row the button is on.

Insert Row (above) Inserts a row above the row that the button is on.

Insert Row (below) Inserts a row below the row that the button is on.

Move Moves a row up or down in the list.

Advanced Properties Opens advanced properties for a row. (Not available on all tabs)



Data Source Section and DB View Relationships Section

Use the Data Source (Views and Tables) page to define which tables (DB_Views) you want to use to
populate data in your report. You can select one or multiple data sources. You can also select templates
that give you access to sets of customs fields/attributes configured for a record, a workflow task, an
address, a parcel, an owner, a condition, a licensed professional, or a contact for the agency.

When you select more than one data source, Civic Platform prompts you to create joins between the tables
using the DB View Relationships section. A ‘join’ is when you combine records from multiple tables by
using a common value that the tables share. You can choose the type of join you want to use. Options
include inner joins, cross joins, and outer joins (left, right, and full).

Your administrator defines which data sources are available to each user. He can use Report Manager to
enable data access to each DB_View, both by User Group and by Module.

For additional reference, see Izenda's Data Sources Tab documentation.

The following table describes the buttons and fields available on the Data Source (Views and Tables)
page.

Table 93: Data Sources Buttons, Fields, and Columns

Button/Field Description

Report List Returns user to the list of Accela ad hoc reports.

Add Fields Enabled after you define one or more data sources. Use to move on to the next
step in your report creation process: field selection and field definition.

Allow Nulls Creates a left outer join between the tables. When you do this, the report creates
a record for the value in the left-most table, whether there is a record in the right
table or not.

Distinct This option duplicates from the result set. When you select this option, Civic
Platform inserts the DISTINCT clause into the sql SELECT statement you are
building. After you select fields in the Fields tab, you can click SQL to see how the
DISTINCT clause appears in the SELECT statement that you are creating.

Name column Indicates the name of a data source. Select each data source that you want to use
for reporting. If you specify multiple data sources for reporting, you need to create
joins between the data sources.

Description column Provides a description of a data source.

Number of Selected
Templates column

Indicates the number of templates that you choose to include in your data source
for reporting. You can select the additional information fields contained in the
selected template and define them as report criteria.

Templates button

If templates (sets of customs fields/attributes) are available for a data source, this
button displays in the Template column. It displays a template selection list for the
selected data source. For more information, see Adding Templates to Your Data
Source.

Fields Tab

Use the Fields tab to define which fields you want to include in your report. The list of fields available to you
depends on the data source(s) you select in the DB View Relationships section.

Each field you add on this tab appears as a column on the report. The order of the fields from top to bottom
determines the display order (left to right) of the data columns on the report. For example, if you add
RECORD_ID, followed by DATE_OPENED, and DATE_CLOSED in the Fields tab and then click Preview,
you see three columns of data displayed. The columns, from left to right, are Record ID, Date Opened, and
Date Closed.

After you select a field, you can define how the data for that field displays in the report by setting field
attributes as described in the following tables.



For additional reference, see Izenda's Fields Tab documentation.

Field Tab Tables

• Fields, Buttons, and Basic Field Attributes on the Fields Tab

• Advanced Field Attributes

• Function Attribute Options

• Format Options for Numerical field types

• Format Options for Date field types

Table 94: Fields, Buttons, and Basic Field Attributes on the Fields Tab

Attribute Description

A This attribute for a given field uses an arithmetic operation to create a calculated
column in your report, such as column A = column B + column C. Click multiple
times on the box to cycle through the available operators (add, subtract,
multiply, divide). See Creating a Calculated Column for information.

Add Pivot Invokes the Pivot feature, which enables you to create a breakout of additional
detail on data in your report, essentially adding extra ‘pivot columns’ to the
right side of your report. For example, you create a report that lists the sum
of payments by payment type. You can use Pivot to add additional columns
that break out the payment sums by month in addition to the original sum of
payments by payment type. See Adding a Pivot Column for more information.

Add Subtotals Creates sub-totals when you have applied visual grouping. A subtotal for each
group displays. The ad hoc report writer makes a best guess at which field is
to be sub-totaled and the function to use. If you want to change the subtotal
function, use the Subtotal Function drop-down list in the Advanced Attributes to
choose the function you want.

Continue to Summary After you define one or more data sources and then set up the fields you want
to display, this button becomes active. Use it to move on to the next step in your
report creation process: defining a report summary.

Description The ad hoc report writer uses this field attribute as the column header in
the report. When you select a field, the ad hoc report writer writes a default
description to this box. You can modify the field description/column header as
needed.

Field The field(s) you are adding to your report. The order in which fields appear on
this tab (top to bottom) is the order in which the ad hoc report writer displays
field data (left to right) in columns when you run the report. This drop-down list
auto-populates based on the data source(s) you define.

Format This field attribute defines how you want the data for a given field to display. The
contents of this attribute drop-down list varies, depending on the field type. For
text fields, this list is empty. For number fields, you have a variety of options.
See Format Options for Numerical field types and Format Options for Date field
types for formatting options.

Function This field attribute applies a function to a given field. If you apply a function
to one field, you must apply a function to all the fields in your report. If you
select the Group option, you can create a group of fields. See Function Attribute
Options for available Function options.

Preview Shows a preview of the report you are creating.



Attribute Description

Records field This restrict the number of records returned when you preview the report. For
example, if you enter 25 and then click Preview, your report displays only 25
rows of data.

Sort This sorts the rows in your table in ascending order based on a given field. To
sort rows in descending order, go to Advanced Field Settings.

VG This changes the field values for the current field into subheadings, grouped
by field value. See Visually Grouping by Field Value for more information about
using visual grouping.

Hide Grid Hides or shows table grids for report styling.

Remove All Removes all fields from the report in the Viewer.

For descriptions of the advanced field attributes, see Izenda's Advanced Field Settings.

Table 95: Function Attribute Options

Function Name Description

Group Groups field values together for aggregating

Count Counts the number of values in a column.

Count Distinct Counts the number of distinct values in a column.

Sum Sums the value in a field.

Average Takes the average value of a field.

Maximum Takes the maximum value in a field.

Minimum Takes the minimum value in a field.

Group(Date),(Day), (Month),
(Year)

Groups a date field by value.

Table 96: Format Options for Numerical field types

Format Option Description Examples

0,000 Displays the number as a whole number. 11231,2341,234,567

$0.00 Displays the number as currency $123.45$0.12

0.0 Displays the number with one decimal place 123.5

0.00 Displays the number with two decimal places 123.46

0.000 Displays the number with three decimal places 123.456

0% Displays the number as a percentage 1%12%

Table 97: Format Options for Date field types

Format Option Description Examples

Short Date Displays the date using the mm/dd/yyyy format 8/1/1996

Long Date Displays the day of the week, month, numeric day,
and the year

Friday, August 09, 1996

Short Time Displays time as hh:mm AM/PM 12:34 AM

Long Time Displays time as hh:mm:ss AM/PM 12:34:56 PM

Full(short) Displays the Long Date format, followed by the Short
Time format

Friday, August 30, 1996 4:34 PM



Format Option Description Examples

Full(long) Displays the Long Date format, followed by the Long
Time format

Wednesday, October 23, 1996
2:28:37 AM

D&T (short) Displays the Short Date format, followed by the Short
Time format

3/12/1996 7:45 PM

D&T (long) Displays the Short Date format, followed by the Long
Time format

2/27/1996 12:45:13 AM

Form Layout Tool

If your agency has obtained a license key to access the form layout tool in ad hoc reports, you can use the
form layout tool to create forms, edit forms, and add data fields.

The form layout tool uses a standard, easy-to-user document editing user interface. It works in the same
manner as any browser-based text editor which provides:

• WYSIWYG editor with a standard editing user interface

• A source code window to show the underlying HTML code. To open the source code window, click

the HTML button . Customizations entered in the source code window render in the editor and
preview window.

• A preview window. To open the preview window, from the View menu, select Preview. Alternatively,

click the Preview button .

Summary Tab

Use the Summary tab to create a sub-table within your report output that provides a less granular view of
the report data; for example, a high level overview in addition to the report details you set up.

For example, you create a payment report that lists the sum of incoming payments by month. You can add
a Report Summary that provides readers with a total count of incoming payments, an average payment
intake value per month, or other useful information.

For additional reference, see Izenda's Summary Tab documentation.

The following table lists and defines the fields and attributes on the Summary tab.

Table 98: Summary Tab Fields and Buttons

Function Name Description

Title This is the title for the report summary.

Records See Fields, Buttons, and Basic Field Attributes on the Fields Tab for a definition of
this field.

Field See Fields, Buttons, and Basic Field Attributes on the Fields Tab for a definition of
this field.

Description See Fields, Buttons, and Basic Field Attributes on the Fields Tab for a definition of
this field.

Sort See Fields, Buttons, and Basic Field Attributes on the Fields Tab for a definition of
this field.

Function See Fields, Buttons, and Basic Field Attributes on the Fields Tab for a definition of
this field.



Function Name Description

Format See Fields, Buttons, and Basic Field Attributes on the Fields Tab for a definition of
this field.

Add Subtotals See Fields, Buttons, and Basic Field Attributes on the Fields Tab for a definition of
this field.

Add Deltas Any time there is a change in a quantity, the ad hoc report writer calculates that
change by taking the later value for that quantity and subtracting from it the earlier
value for that quantity. You can capture this change in a report by selecting the
Add Deltas option.

Continue to Chart When you finish defining a report summary, click this button to move to the next
tab and the next set of actions: setting up charts.

Preview See Fields, Buttons, and Basic Field Attributes on the Fields Tab for a definition of
this field.

Chart Tab

Use the Chart tab to create a chart, or graph, for your report using the data from the data source you
selected when you created your ad hoc report.

Each chart type has a unique set of fields and settings you can use to define how your chart appears.
Choose a chart type from the following list to see a list of fields and settings for that chart type. See
Working with Graphs for more information about creating charts.

• Trend Chart Fields and Settings

• Pie Chart Fields and Settings

• Plot Chart Fields and Settings

• Bar Chart Fields and Settings

• Funnel Chart Fields and Settings

For additional reference, see Izenda's Chart Tab documentation.

Trend Chart Fields and Settings

When you select a trend chart, the following fields and settings are available for you to configure.

Table 99: Trend chart fields and settings

Function Name Description

Separator/Function If you want to compare multiple sets of data on the same chart, use the Separator
drop-down list to define the field you want to use to separate your data. For
example, you can select the same date field you used for the x-axis, and set the
Function to Group(Year). When you run the report, you see separate results for
each year (you can use the Filter tab to set parameters) overlaid on the same grid.
See Trend Chart Example for an example.

Show Legend Displays a legend for your chart.

Show Value Labels Displays the value of each data point.

Smooth Changes the trend line from angular to smooth.

Label Title (Bottom) This is the label for the x-axis.

Label Title (Left) This is the label for the y-axis.



Function Name Description

Scale % This defines how large you want the chart to appear in your report as compared
to the default size. For example, if you enter 75, the chart displays at 75% of the
default size. If you enter 125, the chart displays 25% bigger than the default size.

Pie Chart Fields and Settings

When you select a pie chart, the following fields and settings are available for you to configure.

Table 100: Pie chart fields and settings

Function Name Description

Separator/Function If you want to break out the data into multiple sets, use the Separator drop-down
list to define the field you want to use to separate your data. For example, you can
select the Date_Payment field and set the Function to Group(Year). When you
run the report, a pie chart for each year displays (you can use the Filter tab to set
parameters).

Show Legend Displays a legend for your chart.

Show as 3D Displays the pie chart in a 3D view.

Explode Largest Slice This causes the largest slice of a pie chart to be extracted slightly from the main
body to make it more visible.

Show Percentage Displays the percentage value of the total that each slice of the pie represents.

Show Value Labels Displays the actual value (from the Value field) that each slice of the pie
represents.

Show Slice Labels Displays the actual value (from the Label field) that each slice of the pie
represents.

Combine Bottom % This is a percentage value that represents a combined percentage value. It is used
to combine the smallest slices into a single group and label the group as Other
on the chart, For example, to combine the bottom 10% of slices into one, enter
10. The ad hoc report writer adds the smallest percentage values together, not to
exceed 10% and displays the aggregate value as a single slice.

Chart Type This is the type of pie chart. Options include Pie or Doughnut.

Scale % This defines how large you want the chart to appear in your report as compared
to the default size. For example, if you enter 75, the chart displays at 75% of the
default size. If you enter 125, the chart displays 25% bigger than the default size.

Target Report This enables you to select a sub-report for your chart. You must create and save a
sub-report before you can use it as a Target Report. When you run the report, the
sub-report displays when you invoke the effect you choose in the Effect field.

Effect This is the effect you want to use to display the sub-report selected in the Target
Report field. Choices are Popup (sub-report displays in a popup upon click of a
pie slice), Hover (sub-report displays in popup on mouseover of a pie slice), and
Link (sub-report displays in a new window upon click of a pie slice).

Plot Chart Fields and Settings

When you select a plot chart, the following fields and settings are available for you to configure.



Table 101: Plot chart fields and settings

Function Name Description

Separator/Function If you want to compare multiple sets of data on the same chart, use the Separator
drop-down list to define the field you want to use to separate your data. For
example, if you chose a date field for the x-axis, you can select the same field as
the Separator and set the Function to Group(Year). When you run the report, you
see a separate plot line for each year (you can use the Filter tab to set parameters)
overlaid on the same grid.

Show Legend This displays a legend for your chart.

Connect This connects the plot points on the chart with a line.

Auto-Scale

Scale % This defines how large you want the chart to appear in your report as compared
to the default size. For example, if you enter 75, the chart displays at 75% of the
default size. If you enter 125, the chart displays 25% bigger than the default size.

Bar Chart Fields and Settings

When you select a bar chart, the following fields and settings are available for you to configure.

Table 102: Bar chart fields and settings

Function Name Description

Separator/Function If you want to compare multiple sets of data on the same chart, use the Separator
drop-down list to define the field you want to use to separate your data. For
example, if you chose a date field for the x-axis, you can select the same field as
the Separator and set the Function to Group(Year). When you run the report, you
see a set of bars for each x value, where each bar in the set represents data for a
given year (you can use the Filter tab to set parameters).See Bar Chart Example
for an example.

Line Value This defines a field to use as the y-axis value in creating a plot line to run on top
of your bar chart. If you define a line value, the Show Pareto option becomes
disabled.

Show Legend This displays a legend for your chart.

Show Pareto This creates a pareto chart that contains both bars and a line graph, with individual
values represented in descending order by the bars, and the cumulative total
represented by the line. If you create a pareto chart, the Line Value field becomes
disabled.

Stacked Select this option if you use a separator value and you want to display the bars in
stacked format rather than side by side,

Horizontal Select this option to display your bar chart horizontally rather than vertically
(default display).

Shade Area Under Line Select this option to apply a shadow to the line created by selecting a field for Line
Value. If you do not populate Line Value, this box becomes disabled.

Label Title (Bottom) This is the label title for the bottom value set of your chart. This title corresponds to
the Label data set.

Value Title (Left) This is the label title for the left side value set of your chart. This title corresponds
to the Value data set.

Value Title (Right) This is the label title for the left side value set of your chart. This label corresponds
to the data set for either the Line Value field or the Pareto plot. If you are using
neither of these, this field becomes disabled.



Function Name Description

Scale % This defines how large you want the chart to appear in your report as compared
to the default size. For example, if you enter 75, the chart displays at 75% of the
default size. If you enter 125, the chart displays 25% bigger than the default size.

Target Report This enables you to select a sub-report for your chart. You must create and save a
sub-report before you can use it as a Target Report.

Funnel Chart Fields and Settings

When you select a funnel chart, the following fields and settings are available for you to configure.

Table 103: Funnel chart fields and settings

Function Description Description

Show Percent This displays the percentage value of the total that each disk represents.

Scale % This defines how large you want the chart to appear in your report as compared
to the default size. For example, if you enter 75, the chart displays at 75% of the
default size. If you enter 125, the chart displays 25% bigger than the default size.

Target Report This enables you to select a sub-report for your chart. You must create and save a
sub-report before you can use it as a Target Report.

Gauge Tab

In the Gauge tab, you can add one or more radial or linear gauges to a report.

For additional reference, see also Izenda's Gauge Tab documentation.

A gauge is a graphical status indicator much like a car speedometer. The gauge displays a needle that
moves within a range of numbers displayed on its outside edges. Gauges display the value of a single
metric.

You can design up to 12 gauges. Designing multiple gauges provides readers with a way to compare
multiple values. Multiple gauges display in a panel similar to the gauge panel in the figure below.

Figure 31: Gauge Panel

You can choose from three types of gauges. Each type is illustrated in the following figures.



Figure 32: Gauge Type Radial 1

Figure 33: Gauge Type Radial 2

Figure 34: Linear Gauge

The following table lists and defines the fields and attributes on the Gauges tab.



Table 104: Gauge Tab Fields and Attributes

Attribute Description

Color This field can be used to adjust the color and color gradient in your gauge. Enter a
percentage value and the color you want to use at that point using this format:

, where

is the percentage value and

is the color you want to apply. You can enter multiple values, separating each value
with a semicolon. For example, we used the following color settings to create the
gauge in Gauge Type Radial 1:

. To see what colors are available to use, go to the Style tab and view the drop-down
list for any element color field.

Continue to Misc When you finish creating gauges, click this button to move to the next tab and the
next set of actions.

Gauge Style This is the gauge style to be used in your report. See Gauge Type Radial 1, Gauge
Type Radial 2, and Linear Gauge for illustrations of the different types.

Minimum/Maximum These fields define the range of values to use for the gauge.

Name This defines a field to use for the gauge labels. Values from the chosen field serve as
labels for each gauge you create. If you have more label values than gauges, Civic
Platform creates gauges for the first x number of labels values sorted in ascending
order, where x is the number of gauges you are creating as defined in the Results
field.

Note:

You cannot directly pick which label value to create a gauge for. However,
you can use the Filters tab to hide the label values you do not want to create
gauges for. See Filters Tab.

Results This is how many gauges you want to show. If you choose to count the number of
products in multiple categories, you could specify that you want to only show the
first 4 categories by alphabetical order. You can create up to 12 gauges. See Gauge
Panel for an example of multiple gauges.

Preview This runs a preview of your report so you can check your report output.

Sort/Function When you create a number of gauges that is fewer the number of available gauge
labels, the ad hoc report writer creates gauges for the first x (number) gauge labels,
where x is the number of gauges you are creating. This field defines how the ad hoc
report writer determines the sort order of gauge labels. For example, if you choose
the same field for Sort as you chose for Name, you can apply a function COUNT.
You can then turn on reverse sort (z to a) to make the highest count appear at the
top of the list.

Target Report This enables you to select a sub-report for your chart. You must create and save a
sub-report before you can use it as a Target Report.

Title Enter a title for the gauge or panel of gauges.



Attribute Description

Value/Function Choose a field from the drop-down list that represents the value you want to measure
with your gauges, then apply a Function to that field that displays the data you
want to see. For example, to create a gauge that measures the average payment
intake, you can choose AMOUNT as the Value, and apply the function AVERAGE
to that value. When the ad hoc report writer creates the gauge, it shows the average
payment intake.

Misc Tab

Use the Misc Tab to add a title, description, header, and footer for your report. You can define what type of
justification that you want to apply for each of these elements as well as for the Report Header Image (the
logo). The choices are (L) left justification, (R) right justification, and (M) middle/center justification. You can
also set permissions for your report, defining whom you want to be able to access your report, and what
you want to allow them to do.

For additional reference, see Izenda's Misc Tab documentation.

The following table lists and defines the fields, buttons, and attributes available on the Misc tab.

Table 105: Misc Tab Fields and Buttons

Field/Button Description

Description This is a description of the report. Toggle the Justification button for the Title field to
define whether you want the text left justified, right justified, or middle justified.

Drill-down Key This defines the drill-down key for use with a sub-report (as defined in the Target
Report field on the Charts tab).

Footer This defines report footer content. Toggle the Justification button for the field to
define whether you want your footer left justified, right justified, or middle justified.

Header This defines Report Header content. Toggle the Justification button for the field to
define whether you want your header left justified, right justified, or middle justified.

Owner This field identifies the user name of the individual who created the current report.

Share With/Rights These fields define who you want to share the current report with, and what
permissions you want to give them when interacting with the report. Select Shared to
allow other users to see your report and modify it. Select Read only to set the report
so that it is only modifiable by the report owner. Select View Only to allow other users
to simply view the report and not make any modifications.

Title This is the title of your report. Toggle the Justification button for the Title field to
define whether you want your title left justified, right justified, or middle justified.

Style Tab

Use the Style tab to customize the look of your table by changing the color of borders, headers, and rows.
When you apply new colors, you can see the end result immediately reflected in the sample grid available
on the tab.

You can set report properties on this page as well. See the table below for a list of properties and
definitions.



Table 106: Style Tab Fields and Buttons

Field/Button Description

Border Color, Header Color,
Header Foreground Color,
Item Color, Item Foreground
Color, Alternating Item
Color

This allows you to select a color from for each table element. Refer to the Sample
Grid below the Restore Default button to see how the colors you choose, appear.

Restore Default This restores the default color settings for the six color fields.

Landscape Printing This prints your report in landscape page format.

Show Page Number This displays page numbers on PDF output reports.

Show Date and Time This displays the date and time of the report run on PDF output reports.

Use Pagination in Webview This enables readers to see pagination in web view. Normally, pagination is not
applicable in web view.

Add Bookmarks for Each
Visual Group

This adds PDF bookmarks for each visual group. You must have applied the VG
attribute to a field and you must print to PDF to see these bookmarks.

Page Break after Visual
Groups (PDF)

This applies page breaks for each visual group, such that each visual group begins
on a new page. You must have applied the VG attribute to a field and you must print
to PDF to see this result.

Minimize grid width This trims the width of the columns in your table to match the widest field value,
eliminating unused space.

Visual Group Style This style applies to visual groups sub-headers that contain more than one field
value; for example, Name and City. You must have applied the VG attribute to more
than one field to see this result.

Items per Page (in viewer) This limits the number of rows displayed per page in your report viewer.

Report Order The Move Up and Move Down buttons allow you to change the order in which the
different parts of your report display. The order in which the parts appear in this field
is the order in which they display when you run the report.

Field/Value Column Pairs This sets the field value style, which can be useful for accounting and financial
reports.

Show main report in Field/
Value Style

This changes the main report table to display in the Field/Value style defined in Field/
Value Column Pairs field.

Show summary report in
Field/Value Style.

This changes the summary report table to display in the Field/Value style defined in
Field/Value Column Pairs field.

Continue to Filters When you finish setting styles, click this button to move to the next tab and the next
set of actions.

Preview This runs your report and check your report output.

Enable Responsive Grid Check this box to enable responsive grids. For details, see http://wiki.izenda.us/
Guides/ReportDesign/12.0-Pivots-in-Izenda.

Pivot columns per exported
page

Specifies the number of pivot columns on an exported page. For details, see http://
wiki.izenda.us/FAQ/Responsive-Grid.

Filters Tab

Use the Filters tab to filter the data from the data source(s) so that Civic Platform uses only pertinent
results in your tables, charts, and gauges.

The following fields and attributes may appear on the Filters tab:



Table 107: Misc Tab Fields and Buttons

Field/Button Description

Filter Field This defines the field on which to filter the data returned from your data source(s).

Operator This defines the operation to perform on the field you selected as the Filter Field.

Values This is the value to which the ad hoc report writer applies the operation. For example,
“Begins With A” returns only those records with entries in the filter field that start with
“A.”

Blank This defines whether you want this filter to return both data that matches the defined
Values and data that has a blank/null value in that field.This control does not affect
the Preview view.

Param This defines whether you want to display this filter and the current settings in the
Report Viewer, allowing the user to change the filter value. This control does not
affect the Preview view.

Show Filters in Report
Description

This writes a read-only summary of the report filters you created to the Description
field for the report.

Require X Parameters in
Viewer

This option require the reader of the report to set one or more filter values before the
report contents display.

Preview Use this button to run your report and check your report output.

Preview Tab

Use the Preview tab to view a preliminary version of the your report, including any table, summary table,
chart, or gauge you added. Return to any of the previous tabs to make changes, then click the Preview
button or tab to see how those changes affect report output.

What You See on the Dashboard Designer

Use the Dashboard Designer to add multiple reports for display in a single viewer. When you select the
reports to display in your dashboard, the ad hoc report writer prompts you to select which report part to
use. You can elect to use the table, the summary, a chart, or gauges - whichever is more useful for your
purposes.

Note:

You must create reports before you can add them to a Dashboard display. See Designing a New Report

The Dashboard Designer contains multiple sets of report selection fields. Each set you define displays a
different report in your dashboard. The table below lists and defines the report selection and the permission
fields available on the report designer, as well as the buttons available in the toolbar.

Table 108: Dashboard Design Form Buttons and Fields

New Creates a new report and opens the Report Designer.

Preview Previews your dashboard design.

Print Prints your dashboard to your computer’s default printer.

Records This is the number of records to show; includes All and All (No scroll bar).

Report This is the report you want to add to your dashboard display.

Report List This returns you to the Report List view.

Report Part This is the report part you want to use in your dashboard display. This list populates
based on the parts (Chart, Gauges, Summary Detail) of the report you selected.

Save This saves your dashboard.



Save as This allows you to save your dashboard with a new name and/or to assign your
dashboard to a category.

Share With/Rights This defines who you want to share the dashboard with, and what permissions you
want to give them when interacting with the dashboard. “Shared” allows other users
to see your dashboard and modify it. “Read only” sets the dashboard so that it is only
modifiable by the owner. “View Only” allows other users to view the dashboard but not
make any modifications.

Title This is the title for the report


